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Introduction 
Thank you for purchasing CertiflexDimension 10.x! 

This Conversion Guide is designed to help you convert your 
CertiflexDimension 9.x data to CertiflexDimension 10.x. 

Please read this guide thoroughly before attempting to perform the 
conversion.  It is extremely important that you follow the instructions as 
directed.  Depending on the amount of data stored in CertiflexDimension 9, 
some conversions may take substantial time.  Following a few simple 
guidelines can save you hours. 

 

Things to Think About Before Converting 
There are certain things you should consider before converting a company 
from Dimension 9.x to 10.x. 

 After installing CertiflexDimension v10 and before you begin converting 
your version 9 data, we strongly recommend accessing v10 and spending 
time exercising and manipulating the sample company data.  It will be 
useful to get the feel of the new features before converting your ‘live’ data 
and processing in the new version. 

 Keep in mind that users, user preferences, user toolbars and security 
settings do not convert automatically since no active users can be in 
either version for this process.  You may optionally convert these setting 
and files by having all user log-out of both v9.x and v10.x.  Next, have one 
supervisor level user log into v10x and select >File and >Supervisor 
Options.  Then select Maintain User List and click >Migrate Prior 
Version.   

 v10 CertiflexDimension includes a new bank account tracking system 
that requires at least one bank account is assigned and active per 
company.  Also, version 9 MICR account data must be converted in a 
process separate from the company data conversion.   Please review the 
Converting Bank Account and MICR Check Data for more detailed 
information. 

 If you have had custom programming on your CertiflexDimension 9.x 
programs, the conversion process may not operate properly.  In addition, 
the features that your prior custom programming added might not be 
included in the standard CertiflexDimension 10.x software.  To insure 
proper conversion and compatibility with custom applications, please call 
1-800-237-8435 prior to converting. 
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Each CertiflexDimension package has specific criteria you should consider 
before converting.  Listed below you will find a brief conversion overview of 
each package, detailing which features will convert and which features will 
not: 

 

System Manager – Universal Files 

  System Manager Files Converted  

i. Default Controls 

ii. Default Jobs 

iii. Consolidated Entity Listing 

iv. Financial Type Formats 

v. Company Master Data/Bank Records 

vi. Rave Forms, Cover Letters, Worksheets, Etc.  

  System Manager Files NOT Converted 

i. Users – See Migrate instructions above. 

ii. External files such as Links.  

System Manager Special Notes 

 

 If you were not actively using the Bank Reconciliation module in 
CertiflexDimension v9, a main bank account will be created during the 
conversion process and assigned a ledger account based on the default 
cash account set in your company’s Master Data preferences.  Due to this 
automated account creation, you will want to verify that the correct bank 
account and ledger information has been defined after conversion.   

Please review the Converting Bank Account and MICR Check Data for 
more detailed information. 

 

 

Client Write-up  

  Client Write-up Files Converted (GL, ATF Vendor and Employees)   

i. Yearly Ledger Accounts and Detail  

ii. Financial Formats 

iii. Ledger Account Notes  

iv. Vendors 

v. Vendor Check History 

vi. Payroll Employees 

vii. Payroll Check History 

viii. Payroll Departments 

ix. Payroll Tax Tables and Codes  

x. Client Checklists and Notes 

xi. Archived and Un-posted Batches 

 

  Client Write-up Files NOT Converted 

ii. None 
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Client Write-up Special Notes 

 You do not need to convert consolidated entities because they are 
compiled when you choose the Perform Consolidation option in Maintain 
Consolidation Entities. 

 If you are using master accounts in v9.x for a company, you will want to 
create an Access list of master accounts after the conversion process for 
this company.  To create an Access List from CertiflexDimension v10 
System Manager Menu, select >Maintain List >Maintain Client Write-Up 
>Ledger Master Accounts.  To create a Master Account Access list, click 
>Build Access List. 

 

 

General Ledger  

  General Ledger Files Converted 

xii. Yearly Ledger Accounts and Detail 

xiii. Financial Formats 

xiv. Ledger Account Notes  

 

  General Ledger Files NOT Converted 

i. None  

 

General Ledger Special Notes 

 You do not need to convert consolidated entities because they are 
compiled when you choose the Perform Consolidation option in Maintain 
Consolidation Entities. 

 If you are using master accounts in v9.x for a company, you will want to 
create an Access list of master accounts after the conversion process for 
this company.  To create an Access List from CertiflexDimension v10 
System Manager Menu, select >Maintain List >Maintain General Ledger 
>Ledger Master Accounts.  To create a Master Account Access list, click 
>Build Access List. 

 

Accounts Payable  

  Accounts Payable Files Converted 

i. Yearly Vendor/Open Item Listing  

ii. Vendor Historical Aging 

iii. Detailed Vendor History 

iv. Recurring Entries 

v. Vendor Notes  

 

  Accounts Payable Files NOT Converted 

i. None  

 

Accounts Payable Special Notes 
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Accounts Receivable  

  Accounts Receivable Files Converted 

i. Yearly Customer/Open Item Listing  

ii. Yearly Posted Transactions 

iii. Sales Codes, Salespersons, Tax Rate and Entities 

iv. Detailed Customer History 

v. Cycle Billing 

vi. Archived Invoices 

vii. Customer Notes  

 

  Accounts Receivable Files NOT Converted 

i. None  

 

Accounts Receivable Special Notes 

WARNING: If you are converting Accounts Receivables data from a prior 
version of CertiflexDimension, it is imperative that you print your 
Unposted Transactions report and Post A/R to Ledger before converting.  
Converting unposted Accounts Receivable transactions will require 
manual ledger updating in CertiflexDimension v10.   

 

 

Payroll  

  Payroll Files Converted 

i. Yearly Employees and Wage/Withholdings  

ii. Department, Codes and Tax Tables 

iii. Detailed Employee Check History 

iv. Employee Notes 

 

  Payroll Files NOT Converted 

i. None 

 

Payroll Special Notes 

None 

 

Job Cost  

  Job Cost Files Converted 

i. Default Job and Default Codes 

ii. Job List (Per Company)  

iii. Yearly Job Code and Detail 

iv. Job Notes 

 

  Job Cost Files NOT Converted 

i. Archived and Deleted Jobs 
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Job Cost Special Notes 

i. If you have archived and deleted a job in v9 that you 
wish to re-open in v10, please contact our Technical 
Support department for assistance. 

 

Inventory  

  Inventory Files Converted 

i. Inventory Items/Location Detail 

ii. Item Detailed History  

iii. Bill of Materials Assemblies 

iv. Item Notes 

 

  Inventory Files NOT Converted 

i. None 

Inventory Special Notes 

i. JOB COST USERS: A new feature in 
CertiflexDimension v10 allows for direct interactivity 
with the General Ledger module.  During the Record 
Inventory Entries process, the Withdrawal to Job 
transaction type will only be available if you have 
activated G/L Direct Interaction in the Inventory 
Master Data settings. To enable G/L Direct 
Interactivity for inventory, click >File >Company 
Maintenance >Master Data Properties and select 
Inventory.  Click on the G/L Direct Interaction tab and 
check the box for G/L Direct Interactivity. 

Order Entry  

 

  Order Entry Files Converted 

i. Orders 

ii. Quotes  

 

  Order Entry Files NOT Converted 

iii. None 

Order Entry Special Notes 

i. None 



 6 

 

Purchase Order  

  Purchase Order Files Converted 

i. Purchase Orders 

ii. Purchase Order Codes and Agents  

iii. Purchase Code Detailed History 

iv. Purchase Order Notes 

 

  Purchase Order Files NOT Converted 

i. None 

 

Purchase Order Special Notes 

 

i. None 
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Things to Do Before Converting Your Data 
Before you start to convert your data, review the following checklist: 

 Create a backup of your CertiflexDimension 9.x data files prior to 
starting the conversion.  While the conversion process does not change 
9.x data, your computer will be accessing large quantities of data in a 
short period of time.  If there is a power outage, your files could become 
damaged.   

 Print the following reports for each company for each applicable 
CertiflexDimension 9.x program you have:   

o Client Write-up - None  

o General Ledger - None 

o Accounts Payable - Aged Accounts Payable 

o Accounts Receivable - Aged Accounts Receivable 

NOTE: If you are converting Accounts Receivables data from 
a prior version of CertiflexDimension, it is imperative that 
you print your Unposted Transactions report and Post A/R 
to Ledger before converting.  Converting unposted Accounts 
Receivable transactions will require manual ledger updating 
in CertiflexDimension v10.   

o Payroll - YTD Earnings Report 

o Inventory - Detailed Cost Report 

o Order Entry - Open Backlog Report by Order 

o Purchase Order - Commitment Report by Order 

o Bank Reconciliation - Last Bank Statement 

o Job Cost - Job Summary and Unposted  

You will print these same reports in CertiflexDimension 10.x after the 
conversion is completed to ensure the data converted correctly. 

 Install the CertiflexDimension 10.x software.   

 Remember to logout of any v9 companies that will be converted.  The 
conversion process will not work on a company file that is currently 
opened in v9.x by you or another CertiflexDimension user. 

 Make sure you run the conversion from the same CertiflexDimension 
10.x installation you want your data files in.  For example, if you put 
CertiflexDimension 10.x on your local drive to test before converting, put 
it on the network and make sure to run the conversion from the network, 
not the local drive.  All data files will be in the data directory in the same 
ADVX directory as the conversion. 

 Verify that you have sufficient available hard drive space before you 
attempt to perform the conversion. To guarantee that you have sufficient 
hard drive space, make available approximately 2 times the space used 
by your 9.x data directory. 

 Warning!  The system converts the majority of data on a per company 
basis.  This means that when you are converting a specific company, a v9 
user cannot have that specific company loaded. 
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 The time and hard disk space required to perform the conversion is 
strictly governed by the quantity of data being converted.  The actual 
conversion time in a normal system will be approximately 2MB of data 
per minute.  Some files will simply be copied from CertiflexDimension 9.x 
to 10.x, while others will be translated one record at a time.    

 It is strongly recommended that you exit all other applications on your 
desktop prior to performing large company conversions.  If you are 
operating on a network, you may wish to convert data when the network 
traffic is light. 
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Converting Your Data 
To launch the v9 Data Conversion Utility, from the CertiflexDimension v10 
System Manager Menu, click >Tools and then >v9 Data Conversion Utility.  

 

 
 

The system will prompt you for the following:  

 
 

Select the v9.x Drive/Path.  If you do not know the pathname, click >Browse 
to locate the file: Cfx9\LOAD90.exe 

Select either an Express or Custom conversion style. 

 Express Conversion Style:  Allows multiple companies to be converted at 
one time from the primary v9.x data path and will always convert all 
available files for each company for a maximum of 8 years of detail. 

 Custom Conversion Style:  Allows single company conversion from 
selected company list and prompts for packages to convert with a 
maximum of 15 years of detail. 

Click >Next to continue. 
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Express Conversion Style Process 
 

Select Companies to Convert 

 
Select the individual companies you wish to convert and then click >Process 
to begin converting. 

NOTE:  If you are using the Express Conversion Style, you 
may optionally select to convert all available companies at 
once by selecting >Convert all Available Companies. 

You can select >Include Universal CertiflexDimension System Files check 
box to convert universal files not related to an individual company.  This 
includes F/S lines, job classes, and job categories.  You do NOT need to select 
this check box for each company you convert. 
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Custom Conversion Style 

 
Select Control Folders 

 
If you are using Multiple Company Control Folders, you may optionally 
select the control folder you wish to use.  Click >Next to continue. 

 

Select Company to Convert 

 
Select the company you want to convert.  The company list will only include 
companies that are currently in CertiflexDimension 9.x, but not yet in 10.x. 

 

You can select >Include Universal CertiflexDimension System Files to 
convert universal files not related to an individual company.  This includes 
F/S lines, job classes, and job categories.  You do NOT need to select this 
check box for each company you convert. 

Click >Next to continue. 
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Select Packages to Convert 

 
The system will display the CertiflexDimension program data files for the 
selected company.  If you do not wish to convert data files for a particular 
package, clear the check box.   

WARNING:  Normally you would not remove the checkmark 
from a package’s (i.e. Accounts Receivable, Inventory, etc.) 
check box.  You would only do this if you do not use that 
package for this company any more.   

If you chose not to convert data files for a particular package 
and then decide later on that you need that package, you 
must create the files from scratch. 

Select the number of years of data you want to convert for each available 
CertiflexDimension program.  You can convert up to 15 nine years of data.  
Click >Next to continue. 

The system will calculate the resources needed to process the selected 
company.   

 
To start the conversion, click >Begin. 
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After Converting a Company 

Log on to CertiflexDimension 10.x and print the following reports (if 
applicable) for the newly converted company.  Compare these reports to the 
ones you printed in CertiflexDimension 9.x before beginning the conversion 
process. 

 Client Write-up - None  

 General Ledger - None 

 Accounts Payable - Aged Accounts Payable 

 Accounts Receivable - Aged Accounts Receivable 

 Payroll - YTD Earnings Report 

 Inventory - Detailed Cost Report 

 Order Entry – Open Orders Backlog Report by Order 

 Purchase Order - Commitment Report by Order 

 Bank Reconciliation - Last Bank Statement 

 Job Cost - Job Summary and Un-posted  

 

NOTE:  If the conversion was interrupted or was not 
completed, you must delete any partially created company 
files in 10.x.  To delete a partially created company in v10, log 
on to CertiflexDimension 10.x.  Click >File >Supervisor 
Options >Advanced System Maintenance Options.  Select 
the >Delete Company Files tab, enter the company number, 
and then click the >Delete Files button.  Now that the 
partially created company has been fully removed from 
CertiflexDimension v10 it should once again be available on 
the v9 Data Conversion Utility’s list of companies to convert. 
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Converting Bank Account and MICR Check Data 
When converting a company, you will need to consider how your  

 

Converting Bank Account data 

If you have subscribed to the Bank Reconciliation module, the 
CertiflexDimension v10 Data Conversion utility will automatically convert 
your bank account information during standard conversion processes (see 
above). 

If you are not actively using the Bank Reconciliation module and/or running 
other modules which are interactive with your General Ledger, the system 
will automatically create a bank account for your converted company based 
on the default cash account set in your company’s Master Data preferences.  
Due to this automated account creation, you will want to verify that the 
correct account and ledger information is defined after performing the 
conversion to v10.  To verify your bank account settings, click >File 
>Company Maintenance >Maintain Bank Accounts.  To make changes to a 
bank account, select the account from the listing and click on the Edit button. 

 

Converting MICR Account data 

If you have licensed the MICR check printing module for both v9 and v10, you 
will need to manually convert your v9 MICR account.  To convert your v9 
MICR accounts, click >File >Company Maintenance >Maintain Bank 
Accounts.  Select the desired bank account from the listing and click on the 
Edit button. 

In the upper right corner, under Additional Options, click >MICR Checks to 
display the Maintain MICR Check Options screen. 

 

Under Options & Services, click >Convert v9.x MICR. 
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This option will allow you to convert the setup of CertiflexDimension v9.x 
MICR accounts for the current company.   

First, you must select the v9.x company list file by selecting >Browse and 
then opening the Control0.CDN file, found in Cfx9\Data\Db. The MICR 
conversion program should then locate the required company list.   

Click >Open MICR List and the company’s MICR Account List will be 
displayed.  Conversion of multiple bank accounts will need to be performed 
one bank at a time.  Select the v9.x MICR account you wish to convert and 
then click >Convert Now.   

Once you have finished converting all of your v9 bank accounts, click >Close.   
 


